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Important
Make sure you read and fully understand this manual before operating your 

automated machine. Failure to do so will put yourself and others in harm 

and will void the warranty of this equipment. 



Intended Use of Machine

• Machines are designed to automatically 
produce Channel Letters out of:

• Aluminum Coiled Stock Material in thickness of:

• 0.032”
• 0.040”
• 0.063” (Reverse Channel Letters Only)

• Aluminum Coiled Stock Material in Width of:

• 1.0” through 5.3”

• Machines are not intended for:

• Bending, Notching, Flanging, or Shearing steel or 
similar materials without custom tooling.
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Bending Capabilities:
• Smallest positive or negative radius bend 

is .25 Diameter 
• Maxime break bend angle 120 degree

Closest distance between break 

bends:
• Positive to a positive break bend .375
• Negative to a negative break bend .375

3 different Flange depths:  
• .5” standard for attachment with Letter 

Lok
• .25” for attachment with spot welder
• Or no flange for attachment with MIG 

welder



Radius Bend Bypass

• Radius Bend Bypass is when the machine skips over small 
sections of a radius bend, this is necessary in special occasions 
so that the machine doesn’t distort a previous break bend. The 
machine’s Artificial Intelligence “AI” does all the calculating 
automatically, so you don’t have to manually manipulate the 
artwork.

Skip Rule 1, Break bend to Radius Bend

• If the machine makes a break bend and a radius bend starts from 
that break bend, then the material must feed out 3/8” so that the 
break bend is clear of the bending bar. This prevents the Bend Bar 
from colliding into the break bend or missing the material and 
jamming the machine.

Skip Rule 2, Roll Bend at the start of a letter 

• A Roll bend that starts at the beginning of a letter with no leading 
tab, will be skipped until the material feeds out enough to engage 
the bend bar. If you use a “Leading Tab” which is the  default tab, 
you will never encounter this rule. If you select “No Tab” then you 
could encounter this rule.

• Bump bending radiuses do not apply to this rule. 
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Intended Use of Machine Continued



Introduction
Everyone at CLN of South Florida, Inc. would like to 
thank you for purchasing the CLN Brand Bending 
Machine. We understand that you had a choice and 
you picked ours. Before you get started, there are a 
few things that we need to go over. 
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Purpose of this publication

• To help guide you through the learning curve of 
setting up and operating a new piece of automated 
equipment.

• As a training aid.

Contents
This manual will take on average about an hour to read 
and doing so will help you to better understand the 
machine functions and operations. 

Disclaimer

CLN of South Florida, Inc. makes every effort to provide 
their valued customers with current and accurate 
information about their equipment. However due to 
constant research and development and an 
unsurpassed passion to provide our customers with the 
latest in cutting edge technologies, we cannot guarantee 
that the contents of this manual are current and 
complete.   

Copyright

This manual contains information that is copyright 
protected. All rights are reserved. No part of this manual 
may be repurposed or reused without consent from CLN 
of South Florida, Inc. 

We highly recommend that you click on the 

link below and watch the video on this step

Introduction Video

https://youtu.be/TEM-LeQemgU


Table of Contents

Safety

Machine Overview and Assembly

Machine Maintenance 

Machine Operation

Machine Software

Trouble Shooting

CLN Fusion Manual Ver. 2 7



Safety

Your Responsibilities:

• As an operator of the CLN machine, you are responsible to follow all safety procedures. Any person who operates or does any 
maintenance on this machine must be aware of all safety procedures.
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Safety Precautions:
• Do not wear any loose-fitting clothing such as scarves or hanging jewelry.
• Do not put hands in or on any moving parts at any time.
• Do not operate machinery while under the influence of alcohol, drugs or any other substance that may impair 

or alter your judgment.
• Always wear gloves when handling sharp materials.
• Always wear eye and hearing protection when operating equipment.
• Do not operate the machine without all of the covers in place.

• Keep hands, head and body out of the way of moving parts.
• When performing maintenance work on the machine always unplug the incoming electric power and 

disconnect the compressed air supply. Make sure the air is completely drained out of the system.
• Be sure to stay clear of moving parts when turning on the air supply, the tools may unexpectedly move 

during the initial connection.
• Never leave the machine unattended.
• Completely power down when not in use.
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• When opening the side covers, you must first unplug the machines electricity, disconnect the compressed air line and completely 
drain the air out of the system. If you do not disconnect the electric power and the compressed air line and drain the system, 
you will put yourself at serious risk of causing permanent damage to yourself or death.

Opening the Side Covers:

Guidelines:

• Follow the safety rules at all times. Under no circumstance should equipment be used for anything other than what it is designed for. 
Any person who operates or does maintenance on this equipment should be aware of all safety and operating procedures. It is 
extremely important that this equipment is handled with care! Distractions such as horseplay, carelessness, loud noises and sudden 
movements can result in unsafe conditions, therefore, should be avoided at all times when operating equipment.

Environmental Considerations:

• Climate Control
• The machine should be in a climate-controlled area and NOT exposed to extreme temperatures and or weather.

• There are components on the machine that are susceptible to corrosion and should NOT be exposed to any water based 
lubricant fluid or humidity.

• Clean Working Conditions 
• Your machine should be located in a clean environment.
• Keep your machine and work area free of dirt and debris.

• Lighting
• Your machine should be operated in a well lighted area.  
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Caution Labels:

Emergency Stop:
This machine is equipped with 2 emergency stops one 
located at the front of the machine and the other located 
next to the monitor. Pressing it will halt all motion on the 
machine as well as bleeding all of the compressed air 
from the machine's pneumatic cylinders. The machines 
computer and monitor are the only two components that 
will remain on with the emergency stop pressed. 

Danger Stay clear sticker: Means that 

the machine moves automatically and will  

move without warning and cause serious 

damage to anyone that puts any of there 

body parts in the area.

Warning sticker: Means that the area 

around the sticker moves automatically and 

will move without warning and cause 

serious damage to anyone that puts any of 

there body parts in the area.

Danger Hazardous Voltage sticker: 
Means that the area around the sticker can 

cause an electrical shock to anyone that 

puts any of there body parts in the area.



Machine Overview and Assembly

Components 

Overview

Electronic 
Components 

Overview

Fusion Footprint

Fusion Plus 

Footprint

Assembly

Electrical 

Connection  

Compressed Air 

Connection

Internet 

Connection
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Components Overview:

*Machine displayed with the covers removed.

Rear Front

Left Side Right side

Front Rear 



Decoiler 

• The Decoiler aids in feeding the material through the machine. It is very 
important that the Decoiler is at the same height as the CLN Fusion so that 
the material enters the machine at the same height that it leaves the decoiler. 

Straightener

• With the right tension setting this will take the natural bend out of the material 
that was caused by being wrapped in a coil otherwise known as the “memory” 
of the coil. 
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Components Overview Continued:



Material Feed Assembly

• The drive rollers simply move the material through the machine. 
There are two shafts that have two guide rollers on each of them, 

four total. One of the shafts is powered by a servo motor mounted on 
the underneath side of the drive box assembly. The other shaft is just 
a guide roller. 

Encoder

• When the Servo Motor feeds material through the machine, the 
encoder keeps track the actual distance the material has traveled. If 
there is a discrepancy the encoder tells the motor to make a 
correction. The encoder is located just after the rollers and before the 
homing cell. 
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Components Overview Continued:



Material Homing Sensor

• This is a Proximity Sensor located just after the last set of V-Groove Material 
Guides. It senses the material as it moves past the sensor. When the 
material is in front of the sensor a red LED light will illuminate. 

Notcher Assembly

• The notcher assembly consists of two notchers. The first notcher is a 30 
Degree notcher and the second is a 100-degree notcher. The 30-degree 
notcher is used for negative bends and radius bends, as well as a 6-inch 
repeating relief notch for the flanger. The 100-degree notch is used for 
positive brake bends.  
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Components Overview Continued:



Flanger Station

• This is where the 90-degree flange is bent on the edge of the 
Channel Letter. It is comprised of a material clamp and a flanging 
ram. This will bend the flange in 6-inch increments. 

Bending Tool Assembly

• The Bending Tool Assembly has clamping brake bend dies which 
allow for a sharper brake bend. When making a radius bend these 
dies will rotate out of the way allowing the machine to roll form 
smooth radiuses. 
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Components Overview Continued:
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Components Overview Continued:

Broach Station used in Fusion Plus only

• This is where the machine scores the material by using a spinning 
cut wheel. The wheel spins and moves down then up. It also rotates 
to whatever angle that the bend angle is for the letter. 



CLN Fusion Manual Ver. 2 18

Electronic Components Overview:

Electrical Panel

• Main I/O Breakout Board

• Contactor

• Relays

• Controller

• Sub I/O Board

• Encoder Crossover Board

• 24 Volt Supply

• Servo Drives

• 8 position Valve Manifold

• 6 position Valve Manifold

• Main Air Valve

This is a Fusion Plus back panel. The only difference between the

Fusion and the Fusion Plus  is that the Fusion has only 2 servo drives.
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Valve Manifolds

• The machine has 2 Valve manifolds that control all of the tools in the machine. The 
one on the left is the 8-position manifold and the one on the right is the 6 position.

• The blue buttons will override the valve when you push them. If you push them and 
turn them a ¼ turn clockwise it will lock the valve in the on position. To release it just 
push and turn it a ¼ turn counterclockwise.

Electronic Components Overview Continued:

Valve station identification:
Station 1 from left to right 

1 First Notcher

2 Second Notcher

3 Flanging Station

4 Top Bend Bar

5 Break Bend Dies

6 Break Bend Die Support

7 Sharp Die Lock

8 Bottom Bend Bar

Station 2 from left to right

1 Shear Arm Drop

2 Shear Lock

3 Shear Cut

4 Bump Bend Shim

5 Drain Hole Punch

6 Broach Material Clamp (Fusion Plus Only)
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Servo Drives

• The servo drives power the servo motors. Its normal for them to have random 
numbers on them. The numbers are only positions of the motors. However, 
they also can tell us if something went wrong with the motor or the drive. If you 
receive a servo fault message from the Fusion program the drive will most 
likely display an error code. For example, AL.011 is an encoder issue.  See  
Delta Servo Fault codes go to page 288 for a complete list. 

Electronic Components Overview Continued:

Servo Drive identification :
From left to right

1 Feed System

2 Bend Head

3 Broach Arm Up and Down (Fusion Plus only)

4 Broach Arm Rotate (Fusion Plus only)

https://www.deltaacdrives.com/Delta-ASDA-B2-User-Manual.pdf
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Machine Footprint:

• Make sure you have at least 48” of clear workspace around the perimeter of 
the entire machine to ensure a safe working area for the machine operator.

Fusion Footprint:
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Machine Footprint:

• Make sure you have at least 48” of clear workspace around the perimeter of 
the entire machine to ensure a safe working area for the machine operator.

Fusion Plus Footprint:
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Assembly:

Inspect the Package:
• Prior to opening the package, check for any damages that 

may have occurred during shipping.

Disassembling the Crate
• Remove the top of the crate.

• Remove the Decoiler side of the wall of the crate.

• Remove the Decoiler and cardboard box.

• Unbolt the Fusion Machine from the base of the crate.

• Now carefully lift the machine off of the base of the crate 

with a forklift. THE MACHINE IS EXTREMELY TOP 

HEAVY.

• Set in place and level the machine with the leveling feet.
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Machine Set Up:

• Remove the Side Doors of the Fusion Machine by lifting up 

and tilt the bottom of the door out toward you.

• Install the computer on the shelf and plug in all of the 

computer cables to the back of the computer.

• Remove the tape that is on the wire covers.

Assembly Continued:
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• Machine Set Up:

• Install the Decoiler on the rear of the machine. “Caution” the 
Decoiler is heavy. This is a 3-person job. 2 people hold it in 
place and 1 person puts in the bolts.

Assembly Continued:
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• Machine Set Up:

• Make sure that you use the shim piece between the 
straightener and the Decoiler frame.

• Install the Straightener on the Decoiler frame.

Assembly Continued:
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• Machine Set Up:

• Don’t misplace the small parts. Don’t throw anything away 
until your sure that you know that you have everything. 

• Install the tools in the tool holder located behind the drive 
box.

Assembly Continued:



Electric Power Connection:

• This machine requires a 220 Volt AC, 20-amp electric supply. 
(If needed contact an electrician to install the required outlet 
near the machine.)

• A 6ft cord is supplied with the machine.

• Plug the female end of cord into the outlet on the rear of the 
machine.

• Plug the male end of the cord into the 20-amp outlet installed 
by your electrician.

• Most shops that have 3 phase can also have high leg. You do 
not want to be connected to the high leg! You will damage the 
electronics in the machine. Your electrician will have to 
purchase all of the damaged components.

• Test the power at the plug before you plug in the machine! L1 
to ground should be 120VAC. L2 to ground should be 
120VAC. L1 to L2 should be 208 to 240VAC.

• L1=120  L2=208 L3=120 High leg

L1=120  L2=120  L3=120 No High leg 
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Electrical Connection:



Connecting the Compressed Air Line:

• An air compressor with a minimum capacity of 5 CFM at 80 PSI is required for the 

machine to function.

• Connect your air supply to the side of the regulator marked in. The picture shows 

fittings that CLN uses. You can use any suitable hose connection.

• When the air line is connected to the machine, the gauge on the air regulator should 

read 80 psi. While the machine is running the gage should not drop more than 10 

PSI.
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Compressed Air Connection:
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Internet Connection:

Internet Installation:
• It is the user's responsibility to connect the PC to the Internet. 

• There is a Network Adapter on the rear of the computer that you can connect an Ethernet cable to.

• You can also install a Wireless Network Adapter to the computer if you wish to connect wirelessly. 

• To receive the most efficient technical support for one of our highly skilled technicians it is imperative 

to have internet connectivity for them to assist you.

• Our customer support team can log onto your machine through a software call Team Viewer if you 

need assistance. For this software to work properly you must be connected to the Internet.

*Cable not included



Machine Maintenance  
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Grease 

Locations

Oil 

Locations

Water 

Separator

General 

Inspection
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Grease Locations:

Grease Needle: The grease needle is used to reach 

hard to access areas of the machine. A standard grease 

gun will fit the grease fitting located in the rear of the 

grease needle.

Applying Grease: Grease the machine every 40 

hours. Don’t over grease the machine. A small amount is 
all that is needed. The grease won't disappear, it will 

work its way out to where it's intended to be affective. 

Then you will have to wipe up the excess.



Grease Locations Continued:

Notcher Assembly: Apply all-purpose grease to 

these locations.

Grease Needle: Brush:

Grease Gun:
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Flanging Assembly: Apply all-purpose grease to 

these locations.

Grease Needle: Brush:

Grease Gun:

Grease Locations Continued:
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Bend  Head Assembly: Apply all-purpose grease to 

these locations.

Grease Needle: Brush:

Grease Gun:

Grease Locations Continued:
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Shear Assembly: Apply all-purpose grease to these 

locations.

Grease Needle: Brush:

Grease Gun:

Grease Locations Continued:
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Encoder Assembly: Apply all-purpose grease to 

these locations. Every 6 months

Grease Needle: Brush:

Grease Gun:

Grease Locations Continued:
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Oil and Cleaning the Machine:

• Maintenance schedules will vary from shop to shop depending on production load; therefore, 
these are the minimum guidelines.

• Maintaining a clean machine is imperative to prolonging machine life. Wipe down the outside 
of the machine with mild detergent. Wipe down the raw steel with a Lightweight oil “WD-40”. 

• Apply a lightweight lubricant such as “WD-40” to Notcher Dies and Shear Blades daily.
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Oil Locations:
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Draining the Water Separator:

• Check the Air Filter Regulator for moisture every four hours and drain by pressing up on the 
bottom fitting as needed.

Water Separator:
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Inspect the Machine:

• Preventing a real issue before it happens. Pay 
attention to what's going on with the machine. 
Listen for any strange noises, like air leaking or 
tools moving too fast and slamming into each 
other. A simple air flow adjustment can prevent a 
big problem. 

• Look for any potential mechanical issue like the 
bending die starting to miss align. Again, a small 
adjustment to an adjustment bolt can prevent a big 
problem.

General Inspection:
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Machine Operation  
Turning the 

Machine on 

and off

Compressed 

Air

Loading 

Material

Set up for 

Plastic Face 

Letters

Set up for 

Reverse 

Letters

Set for 

Profiled 

material

Mechanical 

Adjustments
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Power Up Sequence:

• Turn the main power on using the power switch located on the 
rear of the machine.

• The computer should come on when the main power switch is 
turned on. Its set to do this via the BIOS settings. If the computer 
doesn't start, then turn the computer power on by pressing the 
power button on the front of the computer. You will have to open 
one of the door closest to the operator in order to gain access to 
the power switch.

• Wait for the computer to completely boot up.

Power Down sequence:

• Shut the computer down through windows operating system. 
Wait 30 seconds for the computer to completely power down

• Turn off the main power switch located on the rear of the 
machine.

Turning the Machine On and Off:



Check the Air pressure:

• Before you proceed any further, make sure your air 
compressor is turned on and connected to the machine. 
The gauge on the machine should read 80 psi. 

• In order for the machine to function properly your air 
compressor should have a minimum capacity of 5 cfm at 
80 psi.

• While the machine is running the gauge shouldn’t drop 
more than 10 PSI.
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Compressed Air:



Flange Thickness Adjustment:

• The machine is capable of producing a standard 0.5” 
flange, a 0.25” flange or a flangeless letter (Reverse 
Channel Letter).

• The adjustment is made in the Drive Box.

• The front and rear bottom V Groove Rollers can be placed 
in different slots to change the height at which the material 
moves through the machine and this in turn changes the 
thickness of the flange.

• If you have the V Groove Rollers in the deepest slot this 
will produce a 0.5” flange, the intermediate slot will 
produce a 0.25” flange, and the highest slot will produce a 
flangeless letter.
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Loading Material:

Go To Next Page



• When loading material into the machine the Emergency Stop must be 
pressed in. 

• Now that the Emergency Stop is pressed in the drive rollers will be 
disengaged and you will be able to manually feed material into the drive box.  

• Loosen the tension on the straightener by pulling up on the lever and rotating 

it toward the operator.

• Adjust the V Groove Rollers so that they are all the way toward the top of the 
Drive Box.

• Feed material through the Straightener
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• Rest the bottom edge of the material on the 

first lower V Groove Roller and start feeding 

into the Drive Box making sure the material is 

parallel to the base of the machine.

• Use the Handle Wheel to aid in feeding the 

material into the machine.

• Feed the material in until it has moved 

passed the second roller.

• Make sure the material is seated firmly in 

both of the bottom V Groove Rollers.

• Now lower the top V Groove Rollers and 

tighten.

Loading Material Continued:

We highly recommend that you click on the 

link below and watch the video on this step. 

How to load material in the machine

https://youtu.be/V0E6iYu5ubo
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Loading Material Continued:

Support Ramp:

• The support ramp supports the weight of the material as it goes 
through the bend head.

• There are two different support ramps that are used in the 
machine. One is for Reverse Channel Letters (no flange) and 
the other is for standard plastic face channel letters (with a 
flange).

• To switch out the ramp. Press the emergency stop button. 
Remove the right-side deflector, loosen the set screw and pull 
the ramp out of the machine. Install the correct ramp for the 
operation then snug up the set screw, do not over tighten the 
set screw. Then replace the deflector. 

We highly recommend that you click on the 

link below and watch the video on this step. 

Support Ramp

https://youtu.be/dJjWqkKPDDY
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Set up for Plastic Face Letters

• Set the V groove rollers for a ½ inch flange, or a ¼” 
flange. See Flange Thickness Adjustment.

• Load the material into the machine See loading material.

• Make sure that the plastic face ramp is installed. See 
Support Ramp.

• Check the material thickness setting. See Material 
Selection.

• Set the Machine mode to Notch Flange and Bend or 
Notch and Flange. See Material Selection.

• Make sure that the 2 guide rollers are lowered. 

• Push the material just past the, material homing sensor.
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Set up for Reverse Channel Letters

• Set the V groove rollers in the highest groove. See Flange Thickness 
Adjustment.

• Load the material into the machine See loading material.

• Make sure that the Reverse Channel Letter ramp is installed. See 
Support Ramp.

• Check the material thickness setting. See Material Selection.

• Set the machine mode to bend head only. See Material Selection.

• Make sure that the 2 guide rollers are Raised up out of the way. 

• Push the material just past the shear.

• Shear the material. This will be the starting point of the letter. See 
Manually Shearing material
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Set up for Profiled Material

• Only the Fusion Plus can run Profiled Material

• Set the V groove rollers in the highest groove. See Flange Thickness 
Adjustment.

• Load the material into the machine See loading material.

• Make sure that the Reverse Channel Letter ramp is installed. See 
Support Ramp.

• Make sure that the Material Support is installed.

• Check the material thickness setting. See Material Selection.

• Set the machine mode to Broach Pos Brk Bends and Bend All 
Bends or Broach All Brk Bends and Bend All Radiuses. See 
Material Selection.

• Make sure that the 2 guide rollers are Raised up out of the way. 

• Push the material just past the shear.

• Shear the material. This will be the starting point of the letter. See 
Manually Shearing material
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Drive Roller Replacement:

• Use a 3/16” Allen wrench to remove the 10 ¼-20 SHCS that hold 
the rear access cover on the material feed assembly. 

• There are 2 ¼-20 SHCS located under the drive pully assemble. 
There are ½” access holes drilled in the drive pully assemble so 
you can access the screws.

• Remove the top plate. Loosen the set screws around the bearing 
and the hand wheel. Remove the hand wheel. Use a 3/16” Allen 
wrench to remove the 12 ¼-20 SHCS.

Mechanical Adjustments:

Go To Next Page
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Drive Roller Replacement Continued:

• Loosen the set screws around the drive rollers. And remove the 2 
drive rollers.

• Inspect the ¾” shaft. Sand any burs with sand paper.
• The shaft should have 4 dimples in it, 2 for each drive roller. The 

set screws are supposed to seat in the dimples.

• Skip this step if you have dimples in the shaft. The early machines 
may not have dimples in the shaft. If the machine does not have 
dimples, you must put them in. Slide the new roller on the shaft, 
remove the set screws. Use a  3/16” drill bit, and carefully stick it in 
the set screw hole and drill the shaft 1/6”. Replace the set screw 
then drill the other hole. Do this for both drive rollers. 

• Tighten the set screws and replace the drive roller assembly plates.

Mechanical Adjustments:
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• Notcher Depth Adjustment:

• You can easily adjust the depth of the notch if your machine is notching either too 
close to the sidewall of the letter or too far away from the sidewall of the letter.

• Loosen the four bolts on the rear of the Notcher Base that you wish to adjust.

• Adjust the jack bolt to raise or lower the notch depth. 

• Once your depth is adjusted tighten the four bolts on the rear of the Notcher Base. 

Mechanical Adjustments:
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• Flange Angle Adjustment:

• If you find that your machine is not bending a perfect 90-degree bend on the 

flange of the letter you can make an adjustment in the tolerance between the 

Bending Ram and the Fixed Die.

• A ½-13 bolt is threaded into the Bending Ram Plate; this bolt holds the plate in 

place.

• The bottom sub plate is stationary.

• Two ¼-20 bolts on either side of the Bending Ram are also used to 

help adjust the Bending Ram up. 

• To increase the flange angle.

• Loosen the ½-13 bolt that is threaded into the Bending Ram Plate. This 

will allow the plate to move up.

• Turn the 2 - 1/4-20 bolts on both sides of the Bending Ram clockwise 

to raise the bending ram. This will increase the flange angle. The bolts 

will adjust the bending ram left and right independently. Check each 

side with a piece of .040 material, use it like a feeler gauge to make 

sure that the bending ram is parallel.

• Gently snug up the ½-13 bolt this will hold the bending ram in place.

Mechanical Adjustments Continued:

Go To Next Page
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• Flange Angle Adjustment Continued:

• To decrease the flange angle.

• Turn the 2 - 1/4-20 bolts on both sides of the Bending Ram 

counterclockwise. Use a soft hammer and tap the bending ram down 

past the desired depth. It’s easer to achieve the desired distance by 
raising the bending ram. Follow the next step.

• Turn the 2 -1/4-20 bolts on both sides of the Bending Ram clockwise to 

raise the bending ram. This will increase the flange angle. The bolts will 

adjust the bending ram left and right independently. Check each side 

with a piece of .040 material, use it like a feeler gage to make sure that 

the bending ram is parallel.

• Gently snug up the ½-13 bolt this will hold the bending ram in place.                                                      

Mechanical Adjustments Continued:
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• Shear Adjustment:

• Adjusting the tolerance is between the Fixed and Moving Shear Dies:

• You should not have any gap between the dies that is observable with the 

human eye. 

• On the valve manifold located far to the right. From left to right, locate air valve 

station # 2. Locate the manual override button on the valve. Press the button and 

turn clockwise ¼ turn. This will  release the shear lock. Then do the same to air 

valve station # 1. The shear will drop into the Shear Receiver. See Valve station 

identification

• Now, press in the Emergency Stop Button. This will drain all of the compressed 

air out of the machine allowing you to safely work on setting the Shear. 

• Loosen the two ¼-20 bolts that hold the shear shims in place. They are the only 

bolts that are in slots on the top of the base plate of the machine. 

• There are two Shear Shims, one on the Fixed Die and one on the Moving Die 

Side.

• Now make an adjustment as needed and retighten the bolts.

• Release air valve Station # 1 by turning the blue button counterclockwise to raise 

the Shear. Once the Shear is raised, release air valve Station # 2 by turn the 

blue button counterclockwise to activate the Shear Lock. Release the 

Emergency Stop and Restart the software. 

Mechanical Adjustments Continued:
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Mechanical Adjustments Continued:
• Break Bend Die Adjustment:

• Realigning the Break Bend Dies is a difficult task and should be done by a 

technician or someone with mechanical skills. 

We highly recommend that you click on the 

link below and watch the video on this step.  

Link to Break Bend Die video

https://youtu.be/Kq6xNLVmrCQ
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• Break Bend Die Sensor:

• The Break bend Dies are opened and closed by using an air cylinder. The sensor 

that tells the machine that the dies are closed is mounted on that air cylinder.

• If you receive a message from the Fusion program that says, “the Break Bend 
Dies hit something,” but there not hitting anything, then you will have to adjust 
the sensor.

• With the machine on, locate valve station number 5 and turn it on. See  

Electronic Components Overview Continued: for details. Locate your sensor in 

the machine. You may have access to it from below the bend head or you may 

have to remove the top cover to gain access to it.

• Loosen the sensor slide it back and forth on the cylinder while you watch the red 

light turn on and off. Move the sensor to the center from where it turned off and 

on then tighten the clamp. You may want to use a marker and mark where the 

light turned off and on for a reference.

• Turn off valve station number 5. 

Mechanical Adjustments Continued:
View from below

View from below
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• Break Bend Die Resting Position:

• The resting position is when the Break Bend Dies has a small opening (Around 

1/8”). When a break bend occurs, the dies close all the way, then the bend bar 

makes a bend in the material. After that the dies open to the resting position. In 

time this position may need adjusting. 

• With the machine on and air applied to the machine, manually turn on air valve 

station # 5. Then turn on station # 7. Now turn off air valve station # 5. (See 

Valve Station Identification).

• The gap should be enough for .063 to pass through. Usually about 1/8” is fine. If 
it needs adjusting loosen the 10-24 jam nut, adjust the jack bolt them tighten the 

jam nut. After you make an adjustment cycle air valve station # 5 a few times to 

see where it’s naturally sitting. 

• After making adjustments. Turn on air valve station # 5. Turn off air valve station 

# 7. Then turn off air valve station # 5. 

Mechanical Adjustments Continued:
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• Bend Bar Sensor Adjustment:

• If you receive a message from the Fusion program that says (the Bend Bar hit the material while 

trying to do a bend), but it did not hit anything. Then you need to check two things. The Bend Bar 

speed and the Bend Bar sensors there are three Bend Bar sensors located on the air cylinders.

• Bend bar speed: When the Bend Bar is activated, it needs to fully extend so that it comes in 

contact with the Sensor within 2 seconds. If the Bend Bar doesn’t make it in time, then it 
assumes that it hit the material. However, it could be just moving to slowly. A flow controller used 

to extend the air cylinder is located by the cylinders rod and to retract, is located on the rear of 

the cylinder. Adjust the flow controller to achieve a reasonable speed. Don’t make it move to fast 
so that it slams into itself. See Flow Controller.

• Lower Bend Bar, Upper Sensor: With the machine on, locate valve station number 8 and turn it 

on. See  Electronic Components Overview Continued: for details. The lower Bend Bar should be 

in the up position. Loosen the sensor slide it back and forth on the cylinder while you watch the 

red light turn on and off. Move the sensor to the center from where it turned off and on then 

tighten the clamp. You may want to use a marker and mark ware it turned off for a reference.

• Lower Bend Bar, Lower Sensor: With the machine on. The lower Bend Bar should be in the 

down position. Loosen the sensor slide it back and forth on the cylinder while you watch the red 

light turn on and off. Move the sensor to the center from where it turned off and on then tighten 

the clamp. You may want to use a marker and mark where it turned off and on for a reference.

• Upper Bend Bar Sensor: Remove the top Bend Head Cover. With the machine on, locate valve 

station number 4 and turn it on. See  Electronic Components Overview Continued: for details. 

The upper Bend Bar should be in the down position. Loosen the sensor slide it back and forth on 

the cylinder while you watch the red light turn on and off. Move the sensor to the center from 

where it turned off and on then tighten the clamp. You may want to use a marker and mark where 

it turned off and on for a reference.

Mechanical Adjustments Continued:



CLN Fusion Manual Ver. 2 60

• Flow controller:

• Flow Controllers are used to control the speed that the air cylinder extends and 

retracts. Only adjust the side of the cylinder that exhaust the air, this will allow 

you to have a smooth control of the cylinder rod.  Note some cylinders are dual 

action, so there will be two flow controllers on certain cylinders.

• Locate the air valve that controls the tool that you need to adjust. See  Electronic 

Components Overview Continued: for details. 

• Loosen the large thump nut. You may need a pair of pilers to crack it loose.

• Adjust the speed by turning the smaller thumb screw by hand. Turn it clockwise 

to slow the air cylinder down and counterclockwise to speed it up.

• After you make an adjustment cycle the air cylinder. Adjust the flow controller to 

achieve a reasonable speed. It should extend or retract within 2 seconds. Don’t 
make it move to fast so that it slams into itself.

• Tighten the thumb nut, then test again to make sure that the speed is 

satisfactory.

Mechanical Adjustments Continued:
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Mechanical Adjustments Continued: Fusion Plus machines only
Broach Wheel Adjustment:   

• To adjust the depth of the cut wheel, loosen the 6 - 1/4 -20 bolts, 3 on each side 

of the base plate. With a soft hammer tap the plate in the direction that you want 

it to go and retighten the bolts. We recommend that you only move it a very 

small amount at a time. Then run the test fie to see if its correct. 

Broach clamp Stops

• Depending on the different types of material that you are running through the 

machine the material clamp stops may need some adjustment. The purpose of 

the clamp stops is to make sure that the clamp plate stays parallel to the 

material. If your running 2-inch .063 material the bottom of the clamp plate will 

come in contact with the material and the top of the clamp plate will come in 

contact with the stops. If you want to change material from .063 to something 

thinner, you will need to back off the clamp stops. 

• To set the stops put a 12-inch piece of material in the between the clamp plate 

just under the stop bolts. This will act as a feeler gauge. With the machine on, 

press and turn clockwise air valve station # 6 on the air manifold located to the 

front of the machine. This will activate the clamp plate. Adjust the 2 - 3/8-16 bolt 

by loosening the jam nut and adjust the bolt until it touches the plate. Then 

tighten the jam nut. 
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Mechanical Adjustments Continued:
Replacing the Upper Lobe and Pin:

Replacing the Pin

• The pin threads into the upper lobe.

• Use a pair of pliers and unthread it from the upper lobe. Then thread 

the new one in. 

Replacing the Upper Lobe

• The upper lobe is attached to a 3/8 round shaft that has a flat 

machines on it. The set screw in the lobe gets tighten to the flat on 

the shaft. Epoxy Like “JB Weld” is used around the 3/8” shaft and the 
inside of the lobe to fill any gaps between the connection.  

• To replace the upper lobe, use a propane torch and apply a little heat 

to the lobe this will loosen the epoxy. Hold the torch on the lobe for 

about 5 seconds.

• Loosen the set screw and gently wiggle the lobe off with a pair of 

pilers.

• Mix a small amount of JB Weld and apply it to the 3/8” shaft and the 
hole of the new lobe.

• Position the set screw over the flat of the 3/8” shaft and tighten.

• Allow the epoxy ample time to fully cure.
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Mechanical Adjustments Continued:
Replacing the Lower Receiver Lobe:

• The receiver lobe is attached to a 3/8 round shaft. The set screw in the lobe gets 

tighten to the round shaft. Red Loctite is used around the 3/8” shaft and the inside 
of the lower receiver lobe to secure the connection.  

• To replace the lower receiver lobe, use a propane torch and apply a little heat to 

the lobe this will loosen the Loctite. Hold the torch on the lobe for about 5 seconds.

• Loosen the set screw and gently wiggle the lobe off with a pair of pilers.

• Test fit the new lobe. Slide it on the shaft, Make sure that it’s 5/8” above the blue 
base plate.

• You must position the receiver lobe to the pin that is in the upper lobe. It is 

important to rotate the bend bar assembly counterclockwise until it stops, then 

clockwise a few degrees. This position is where the machine rotates the assembly 

to lower the bend bar. 

• If the receiver lobe fits snugly on the shaft, use Loctite around the shaft and the 

hole that’s in the new lobe. If there's play, then use an epoxy like JB Weld.

• Position the lower receiver so that the pin slides into it, then tighten the set screw.

• Allow the Loctite or epoxy ample time to fully cure.
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Mechanical Adjustments Continued:
Adjusting the Bend Head Home sensor:

• When the program starts the first thing it ask you, if it is okay to rotate the bend 

head. See Homing the bend head . What it its actually doing is setting a zero for 

the bend head, so the machine knows exactly where the bend bar is located, so it 

can bend the material correctly. 

• If the sensor malfunctions the bend head will rotate counterclockwise pass the 

home sensor and run into the stop and fault the servo drive.

• Remove the top cover.

• To test the sensor, use a piece of metal and wave it under the sensor. A red light 

will appear on the sensor if it is working. 

• Wave a piece of metal under the sensor again and look at the second blue relay 

behind the clear plastic on the electric panel. It should light up green.

• This tell us that the sensor and the relay is working. 

• Let the machine try and home itself, when it fails the servo will fault out. You will be 

able to turn the bend head by hand. Rotate it until the bolt head is under the 

sensor. If the sensor comes on, then there is a bad connection on the relay or the 

breakout board. Or the sensor is right on the cusp of working or not working and 

will need to be adjusted.

• If the sensor doesn't come on, then adjust the sensor down until it comes on. 

Rotate the bend head a few time to test.



Machine Software 
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Types of Bends

Break Bends
• A break bend is two lines meeting together with one point. The program calculates the two adjacent lines and provides an angle. If the angle is greater 

than 15 degrees, then the machine will engage the break bend dies and bend the calculated angle however it will not bend past 170 Degrees. Because 

the bending bar will hit the die.  If it is less than 15 degrees then the machine will skip over it, because less than 15 degrees is a minuscule amount and 

is most likely to be a condition of bad artwork and it is a waste of time.

Radius Bends

• When the program reads a radius, it calculates the size of the radius. It then tells the machine to engage the round die, move the material forward to the 

round die location then engage the round bending roller. Then rotate the bending roller to the correct angle and feed the material through the two round 

dies to form the radius. If the radius is less than .75” the machine will bump it around the break bend die. After every bend the machine makes sure that 

the material did not slip, if it did then the machine will automatically correct itself by using the encoder. 

• Software

The purpose of the CLN software is to give the operator a way to view the artwork that was sent via a DXF and convert it so that the machine can process 
the information correctly. From the CLN Software you can alter the start point, split the letter up into sections, set an inline or outline and set drain hole 
locations.

Software Overview:



Curfing loss

• Curfing loss occurs when the router cuts the letter back, the router bit can’t cut a sharp corner down in the crotch of letters like W or V. 
This routine calculates what the router bit can not cut and compensates for it by subtracting out the difference from the two lines that 
create a negative angle. The setting is called Router Bit Size and is in Options > Software Settings.

CLN Fusion Manual Ver. 2 67

Original Artwork Actual letter back after 

being cut on the CNC 

Router

Curfing Loss

Software Overview Continued:



Start the program:

• To open the operating software on the machine 
simply double click on the desktop icon “CLN 
Fusion”.

• A message will display asking you if it is safe to 
home the bend head.

(Please see Homing the Bend Head before you 
click okay)
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Using The Software:
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Homing the Bend Head:

• If you have material out passed the bend head, click Cancel and the machine will not 

home the bend head at this time. 

• If the bend head is clear and it is safe to rotate the bend head, then click Ok and the 

machine will home the bend head.

• If you click cancel because you have material out passed the Bend Head, the machine 

will not allow you to process a letter until you home the Bend Head. Therefore, if you 

click “Run Tool” the message will display again asking you if it is safe to home the 
Bend Head.

Look and wait for it to finish the rotation sequence.

• The Bend Head message will always come up when you start the Fusion program.

• To save time the machine will not rotate the Bend Head if it has successfully 

completed the sequence. So, when you click okay, it will skip this task.

• Every time that you click Okay to the rotate Bend Head message, you should watch 

the Bend Head and see if it rotates normally. Wait for it to come to a stop on the left 

side of the machine, or the side that’s closest to the monitor, before you continue.

Using The Software Continued:
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Open a DXF File:

• To open your .dxf file and view your 

artwork on the machine, Open the Fusion 

program, go to, File > Open and select 

your file.

• The Artwork will be displayed on the 

screen in a tab called Working. This tab is 

reserved for processing the letters with the 

Fusion machine. Notice that the letters 

have tabs atomically inserted at the start 

point of each letter.

• You can alter your letters, but you have to 

click the back button on the fusion 

program to open the job up in a new 

editing tab. There you have access to the 

editing tools.

Using The Software Continued:

We highly recommend that you click on both 

links below and watch both videos on Master 

file and Artwork setup. Master File and 

Artwork Setup

https://youtu.be/dg9UBB0Ecnk
https://youtu.be/t6OxMpcrT8k
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Material Selection:

• Make sure that you have the machine in 

the right mode for the kind of letter that 

you want to make.

• Machine Mode

• Make sure that you have the right material 

selected for the type of coil that you have 

loaded.

• Material Selection

Using The Software Continued:
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Running A Letter:

• To select the letter, you can either 

click on the letter or hold shift and 

click on more letters. Or drag a box 

around the letters. Dragging a box 

from left to right, you have to drag the 

box completely around the letter. 

Drag a box from right to left you just 

need to come in contact with the 

letter. To select it.

• If the machine is in Notch Flange and 

Bend mode or Notch and Flange 

mode “Standard Channel Letters”. 
You can set a single drain hole by 

clicking on the “Single Drain Hole” 
icon, allow the curser to snap to the 

part of the letter that you want to 

insert a drain hole and click on the 

letter. If you must have 2 drain holes 

per letter. Select the “Add Dual Drain” 
for letters like the “I”. To process the 
letters. Select the letter or letters that 

you wish to run and click Run Tool. 

The machine will begin making 

letters.

Using The Software Continued:
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Splitting A Letter Into Sections:

• To split a letter, you have to first click 

on the back button. This will open a 

new folder that allows you to edit the 

artwork.

• Select the letter. Then click on split 

letter. It will turn yellow when its 

active.

• Click any where you want to split the 

letter. A green square will appear 

letting you know that you cut the letter 

in that spot.

• Click on split letter again to cancel the 

function.

• Click anywhere in the black screen.

• Click on one side of the letter and 

drag or use the arrow keys to move 

the letter away from itself. 

Using The Software Continued:
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Splitting A Letter Into Sections Continued:

• The fusion program can only add tabs for letters that are not split into 

sections.

• Only in the Working folder will you see this. By default, the green Tab will 

be applied for connected letters and the open path letters will have a red 

marker on the start of the letter

• For split letters you have to manually add the Tabs.

• Now that the letter is split into two pieces. You can set a Tab if you need 

one. Click on one piece of the letter to highlight it.

• Right click anywhere in the black screen and select Add Tabs.

• Notice that the F is split in the center and at the corner. Let's focus on the 

left side of the letter for now.

• To set a Tab in the corner, for this part of the letter you need to select  Tab.

Using The Software Continued:
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Splitting A Letter Into Sections Continued:

• A long line will pop up, use this line to set the angle 

of the Tab, then click on the screen.

• A ¾” tab will be inserted.

Using The Software Continued:
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Splitting A Letter Into Sections Continued:

• The other side of the F was split in the center.

• Right click anywhere in the black screen and select 

Add Tabs.

• Select Step Bend. This will add the step bend on 

the beginning part of the letter.

Using The Software Continued:
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Splitting A Letter Into Sections 
Continued:

• Click on Prepare. This will prepare the file for 

the machine.

• Notice that it put the artwork back in the 

Working folder. 

• Inserted green Lead Tabs for the letters that 

are not split.

• Inserted Red markers on the letters that are 

open.

Using The Software Continued:
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Moving the start point:

• Click on the Back Button.

• Click in the black screen to deselect the 

artwork. The start point can not be 

moved while the control points are 

active.

• Click on the Start Point button.

• Click on the letter once to select it. 

• Click on the letter where you want to 

move the start point to.

• Repeat this process for any letter that 

you wish to alter the start point.

• Click on Prepare. This will prepare the 

file for the machine.

• Notice that it put the artwork back in the 

Working folder. 

• Inserted green Lead Tabs for the letters 

that are not split.

• Inserted Red markers on the letters that 

are open.

Using The Software Continued:
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Moving the start point Continued:

• Click on Prepare. This will prepare the 

file for the machine.

• Notice that it put the artwork back in the 

Working folder. 

• Inserted green Lead Tabs for the letters 

that are not split.

• Inserted Red markers on the letters that 

are open.

Using The Software Continued:
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Manual Control:
• There are a few functions on the machine 

that can be manually controlled by the 

operator:

• Feed Material

• Home Material

• Shear Material

Feeding Material
• To Feed material through the machine, click 

on Tools > Feed. You will be prompted with a 

dialog box that you can enter in a value in 

inches of material to be moved. Once you 

click Ok the machine will move the material.

Homing Material
• To Home the material, click on Tools > 

Home. The machine will bring the lead edge 

of the material all the way back to the 

homing sensor. The homing sensor is the 

starting position for standard plastic face 

channel letters.

Shear Material
• To shear the material, click on Tools > 

Shear. As long as you're in automatic shear 

mode, the machine will deploy the shear and 

cut the material. If you're in manual shear 

mode or the shear hits the letter on the way 

down, it will display a message asking you 

to press the shear button.

Manual Machine Control:



Manual shear mode
• To use the shear button to manually shear material. First 

you must be in manually shear mode. Go to tools / software 
settings, uncheck “Auto Shear On” box. Now when you click 
on tools / shear material the machine will then wait for the 
user to press and hold the Shear Button down to complete a 
full Shear Cycle. This mode is useful if you want to wait for 
an operator to confirm that the letter is positioned under the 
shear. Large logos can fall off the table and the shear could 
miss the return as it comes down to cut the letter.

• The Shear Cycle is broken up into two separate 
routines that for safety reasons the user must keep 
the button pressed in though out the shearing cycle.

• The first part of the routine lowers the shear down 
into the receiver. If at any time the operator releases 
the button before the shear lowers all the way down 
into the receiver the shear will retract, and the cycle 
will start over again.

• Once the Shear makes it down into the receiver the 
second part of the cycle will begin. At this point the 
operator can release the button and the Shear will not 
retract, but it will stay in the down position until a full 
cycle of the cutting dies takes place. The user must 
continue to hold the button until the cutting dies close 
all the way, the material is sheared, and the material 
backs up away from the dies a one inch.

• Now the Shearing cycle is complete, and the Shear 
will automatically retract without the need for the 
operator to hold the button.
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Note: Its normal for the program to close when you click Update. This is necessary for the machine

to receive the new settings.

Manual Machine Control Continued:
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• Go to tools / Material Settings. These are settings 

based on the thickness of material that you are running. 

• The Fusion is capable of handling a multiple sizes of 

materials from 0.032” to 0.063”. There are 4 categories. 
The title for each category can be renamed. 

• When bending metal material there is a certain degree 

of spring and memory in the material, so to achieve the 

correct angle the machine has to over bend the 

material. 

• Different material and thicknesses will require slightly 

different over bend specifications. 

• You can teach the machine to remember different types 

of material by adjusting the offset values. The values 

are arbitrary and increasing or decreasing by 2 degrees 

is a good rule of thumb.

• The factory sets the .040 and the .063 category when 

they manufactured your machine, the rest will be very 

close however you may need to adjust them. These 

settings are unique to your machine.

*These are settings are being used as an 

example. Actual Material Settings will 

vary.*
Note: Its normal for the program to close when you click Update. This is necessary for the machine

to receive the new settings

Material Settings:
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Material Definitions Settings and Adjustments:

• You need to run the test files located in C:\Jobs\Fusion Test Files to adjust the following.

• Brake Bend Positive: This adjust the degree of the bend for the positive break bend 
function. Increasing this value will make the machine bend more. Run the file called “Break 
Bend Positive.DXF” Adjust the value until the machine is bending a 90-degree Bend.

• Brake Bend Negative: This adjust the degree of the bend for the negative break bend 
function. Increasing this value will make the machine bend more. Run the file called “Break 
Bend Negative.DXF” Adjust the value until the machine is bending a 90-degree Bend.

• Roll Bend Positive: This adjust the degree of the bend for the positive roll bend function. 
Increasing this value will make the machine bend more. Run the file called “6-inch diameter 
test Pos.DXF” Adjust the value until the machine is bending a 6-inch semi circle. Plus, or 
minus ¼”

• Roll Bend Negative: This adjust the degree of the bend for the negative roll bend function. 
Increasing this value will make the machine bend more. Run the file called “6-inch diameter 
test Neg.DXF” Adjust the value until the machine is bending a 6-inch semi circle. Plus, or 
minus ¼”

• Bump Bend Positive: This adjust the degree of the bend for the positive bump bend 
function. Increasing this value will make the machine bend more. Run the file called “1.5-
inch diameter test Pos.DXF” Adjust the value until the machine is bending a 1-1/2-inch semi 
circle. Plus, or minus 1/16”

• Bump Bend Negative: This adjust the degree of the bend for the negative bump bend 
function. Increasing this value will make the machine bend more. Run the file called “1.5-
inch diameter test Neg.DXF” Adjust the value until the machine is bending a 1-1/2-inch semi 
circle. Plus, or minus 1/16”

• Bump Feed Distance: This is the length of material to be fed through the machine during a 
bump bending routine. .080 works the best.

*These are settings are being used as an 

example. Actual Material Settings will 

vary.*

Note: Its normal for the program to close when you click Update. This is necessary for the machine

to receive the new settings

Material Settings Continued:
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Material Settings Definitions Continued:

• Negative Radius Bend Deduction: This value will shorten the negative 
radius bends. Because the encoder wheel is mounted on the positive side of 
the material, the negative side of the material will grow slightly while the 
machine is bending the return. The amount that the material will grow is 
based on the thickness of the material. .063 will need to be reduced more 
than .032. Actually .040 and smaller needs no reduction because the amount 
that the material grows is not noticeable at all. This value is important for .063 
materials, for reverse channel letters when you are trying to get the return to 
fit on the inside of the letter face. If every location on the letter is good, except 
a negative radius between two break bends, then reducing this value will 
shorten the return between the two-break bends. 1.0 = no deduction. Adjust 
this value by .001

Note: Typically happens on the inside of an upper case “C” The outside of the “C” is 
controlled by the outline from the cad program.

• Negative Brake Bend Deduction: This value will shorten two negative 
break bends that are back-to-back. Because the encoder wheel is mounted 
on the positive side of the material, the negative side of the material will grow 
slightly while the machine is bending the return. The amount that the material 
will grow is based on the thickness of the material. .063 will need to be 
reduced more than .032. Actually .040 and smaller needs no reduction 
because the amount that the material grows is not noticeable at all. This 
value is important for .063 materials, for reverse channel letters when you are 
trying to get the return to fit on the inside of the letter face. If every location on 
the letter is good, except the distance between two negative break bends, 
then reducing this value will shorten the return between the two negative 
break bends. If there is a radius between the two-break bends, then refer to 
“Negative bend factor”. 1.0 = no deduction. Adjust this value by .001

Note: Typically happens on the inside of an upper case “H” The outside of the “H” is 
controlled by the outline from the cad program.

*These are settings are being used as an 

example. Actual Material Settings will 

vary.*

Note: Its normal for the program to close when you click Update. This is necessary for the machine

to receive the new settings

Material Settings Continued:
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• Router Bit Diameter: Depending on what size router bit you are using to 

cut out your letter backs the machine will automatically make calculations 

for the curfing loss that will occur. Set this setting to match the diameter of 

the router bit being used on your CNC Table.

• Maximum Radius Notch Distance: When your machine encounters a 

large radius it will place a notch no farther apart than what you set this 

setting to.

• Comm Port: Typically set to Port 3. This is what Comm Port the computer 

is using to communicate with the controller. 

• Registration Code: Depending on your payment plan your machine has a 

code that will make the machine unusable after a certain period of time. 

Once your machine has been completely paid for you will receive a payoff 

code. 

• Hours Run: This counts the hours that the machine was processing a 

letter

• Test Mode On: Allows the program to be used without being connected to 

a machine.

• Auto Shear On: When this box is checked the machine will atomically 

shear the letter at the end of the process. Otherwise, you will have to press 

the shear button to shear the letter.

Note: Its normal for the program to close when you click Update. This is necessary for the machine

to receive the new settings
*These are settings are being used as an 
example. Actual Material Settings will vary.*

Software Settings:
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• Distance From Home: These values are in 

inches, and they are the distance from where the 

material homes to the respected tool in the machine.

• To First Notcher: To set or confirm that the value is 

correct. Home the material with the manual home 

command. Then copy the value “To First Notcher” and 
paste it the manual feed dialog box. Click okay to move 

the material. Look to see if the material is centered on 

the first notcher. If not make small moves with the 

manual feed command until its centered. Take note of 

all the moves you used to get the material centered on 

the first notcher. Add them up and put them in the “To 
First Notcher” category. Then test your new value by 
repeating these steps.

• To Second Notcher: The second notcher should be 3” 
from the first notcher. This is how to test this. Move the 

material out in front of both notchers. Locate the 8-

position valve manifold press the manual override 

button on air station # 1 and # 2. The machine will 

punch 2 notches in the material. Feed the material out 

past the bend head and measure the center distance 

between the notchers. Put this valve in “To Second 
Notcher.”

• Important: Making a change to the “To First Notcher” 
value will affect the “To Second Notcher” value. It will 
add the amount to the “To Second Notcher” value. 
Making a change to the “To Second Notcher” value will 
NOT affect the “To First Notcher” value. Once they are 
set, they stay grouped together.

*These are settings are being used as an 

example. Actual Tool Settings will vary.*

Note: Its normal for the program to close when you click Update. This is necessary for the machine

to receive the new settings

Tool Settings:
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*These are settings are being used as an 

example. Actual Tool Settings will vary.*

Note: Its normal for the program to close when you click Update. This is necessary for the machine

to receive the new settings

• To Shear: The best way to figure out what this number 

should be, is to run a small letter and see where the shear 

cut the material. Measure the error and add or subtract it 

from the current value. There will be a notch at the end of 

every letter. You're trying to get the shear to cut the center 

of the last notch. If it fall short, then add to the “To Shear” 
value.

• To Break Bend Dies: To set or confirm that the value is 

correct. First home the material with the manual home 

command. Then use the feed material command. Copy 

the value located in “To Break Bend Dies” and paste it in 
the manual feed dialog box. Click okay to move the 

material. Locate the 8-position manifold located under the 

machine, press the manual override button on air station # 

5. Lock the valve on by pushing it in and turning it a ¼ turn 

clockwise. Look and see if the edge of the material is past 

the dies by .02”. If not release air station # 5 by pushing 
and turning the button counterclockwise a ¼ turn. Make 

small moves with the manual feed command check it by 

pushing air station # 5 to close the dies. Repeat until the 

material is .02 past the dies. Take note of all the moves 

you used to get the material .02 past the dies. Add them 

up and put them in the “To Break Bend Dies” category. 
Then test your new value by repeating these steps.

• Important: Making a change to the “To Break Bend Dies” 
value will affect the “To Shear” value. It will add the 
amount to the “To Shear” value. Making a change to the 
“To Shear” value will NOT affect the “To Break Bend Dies” 
value. Once they are set, they stay grouped together.

Tool Settings Continued:
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*These are settings are being used as an 

example. Actual Tool Settings will vary.*

Note: Its normal for the program to close when you click Update. This is necessary for the machine

to receive the new settings

• Distance From Shear: These values are in 

inches and they are the distance from where the 

material homes to the respected tool in the 

machine.

• To Broach: Only for the Fusion Plus. This is the 

distance from the shear to the broach cutting 

wheel. It’s shown as a negative number 
because it measures backwards from the shear. 

This will adjust the start of the letter. Increasing 

this number will move the start of the letter out 

past the break bend dies. So, by Increasing this 

value it will make the distance from the first 

broach notch to the start of the letter longer.

• To Break Bend Dies (Bend Head Only): This 

value is from the break bend dies to the shear 

after it cuts the material and backs up 1 inch. It 

is only used when the machine is in “Bend Head 
Only” mode. It’s shown as a negative number 
because it measures backwards from the shear. 

This value sets the starting position for reverse 

channel letters. Making this value smaller will 

move the cut into the coil stock. This is useful if 

fabricator needs a little extra material to finish 

off the seam piece of the letter. 

Tool Settings Continued:
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*These are settings are being used as an 

example. Actual Tool Settings will vary.*

Note: Its normal for the program to close when you click Update. This is necessary for the machine

to receive the new settings

• Machine Mode: Your machine can be operated 

in different modes. 

• Bend Head Only: This mode will just bend the 

letter. For Reverse Channel Letters.

• Notch, Flange Only: This mode will Notch and 

Flange your return allowing you to bend the letter 

by hand.

• Notch, Flange and Bend: This mode will Notch 

Flange and Bend the Letter. For Standard 

Channel Letters.

• Broach Pos Brk Bends and Bend All Bends:
This mode is only for the Fusion Plus. This mode 

will only broach cut the positive break bend 

locations and will not broach the negative bend 

locations. Then it will break bend all bend, sharp 

bends, roll bends and bump bends the letter into 

shape. This is for Letter Edge Material or anything 

similar.

• Broach All Brk Bends and Bend All Radiuses: 
This mode is for the Fusion Plus. This mode will 

broach cut positive and negative break bend 

locations. It will roll bend and bump bend all the 

radiuses. It will not break bend the sharp bends. 

This is useful if you want to make very sharp 

break bends out of .063 alum. However, this mode 

will weaken the integrity of the break bend. 

Tool Settings Continued:
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*These are settings are being used as an 

example. Actual Tool Settings will vary.*

Note: Its normal for the program to close when you click Update. This is necessary for the machine

to receive the new settings

• Tool Timing: These values are in seconds, and 

they are delays to allow your tooling time to work 

properly. Too much delay and your machine will 

operate slower than normal, too little delay and 

tools in the machine will not clear the material 

before the material feeds and cause a jam..

• First Notcher In Delay: This is the time that it 

takes for the tool to go through the material.

• First Notcher Out Delay: This is the time that it 

takes for the tool to return back from where it 

started.

• Second Notcher In Delay: This is the time that it 

takes for the tool to go through the material.

• Second Notcher Out Delay: This is the time that it 

takes for the tool to return back from where it 

started.

• Flanging In Delay: This is the time that it takes for 

the tool to go through the material.

• Flanging Out Delay: This is the time that it takes 

for the tool to return back from where it started.

• Shear In Delay: This is the time that it takes for the 

tool to go through the material.

Tool Settings Continued:
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*These are settings are being used as an 

example. Actual Tool Settings will vary.*

Note: Its normal for the program to close when you click Update. This is necessary for the machine

to receive the new settings

• Broach Tool: This mode is only for the Fusion 

Plus. These values are all related to the Fusion 

Plus.

• Minimum Notch Angle: This value prevents the 

broach from cutting miniscule break bend angles in 

the letter that are not needed. The value is in 

degrees.

• Distance Broach to Dies: This is the distance form 

the broach cutting wheel to the break bend dies. It’s 
shown as a negative number because it measures 

backwards from the break bend dies. Increasing this 

number will move the broach notch out past the 

break bend dies. 

• Distance Dies to Shear: This sets the distance 

from the last broach notch in the letter to the end of 

the letter. Increasing this number will move the 

material out past the break bend dies causing the 

shear too cut into the coil stock. So, by Increasing 

this value it will make the distance from the last 

broach notch to the end of the letter longer.

Tool Settings Continued:
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*These are settings are being used as an 

example. Actual Tool Settings will vary.*

Note: Its normal for the program to close when you click Update. This is necessary for the machine

to receive the new settings

• Motor Settings: These values are in counts, and 

they are what the machine uses to calculate a 

speed or a distance.

• Feed Encoder Counts Per Inch: This value is what 

you use to calibrate the feed distance of the 

material. Larger the value, the longer the feed 

distances will be. Default value is 1666.0

• Material Feed Rate: This value is used to control 

the speed of the material as it travels through, he 

machine. Larger the value, the faster it moves. The 

range is 0 to 40000.0 Do not exceed the maximum 

value

• Bend Head Rotation Speed: This value is used to 

control the speed that the bend head, bends the 

material. Larger the value, the faster it moves. The 

range is 0 to 50000.0 Do not exceed the maximum 

value

• Bend Head Retraction Speed: This value is used 

to control the speed that the bend head moves away 

Larger the value, the faster it moves. The range is 0 

to 1000000.0 Do not exceed the maximum value

Tool Settings Continued:
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*These are settings are being used as an 

example. Actual Tool Settings will vary.*

Note: Its normal for the program to close when you click Update. This is necessary for the machine

to receive the new settings

• Motor settings continued:

• Broach Up and Down Speed: This value is used 

to control the speed that the Broach moves up 

and down. Larger the value, the faster it moves. 

The range is 0 to 25000.0 Do not exceed the 

maximum value

• Broach Rotation Speed: This value is used to 

control the speed that the Broach rotates left and 

right. Larger the value, the faster it moves. The 

range is 0 to 10000.0 Do not exceed the 

maximum value

• Broach center position: This value is used to 

control the center position of the Broach after it 

finds the homing sensor. A larger value will make 

the Broach move to the right after it homes itself. 

Default value is 4750.0

• Drain Settings: This value is in inches, and it 

will move the location of the drain hole punch.

• Drain Hole Offset: This value is used to control 

the position of the drain hole punch. A larger value 

will move the punch to the left. Default value is 

0.0

Tool Settings Continued:
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Machine Calibration:

Calibrating the Material Feed System:

• To calibrate the feeding system, first load material into the machine.

• Home the material with the manual home command. Click on Tools > Home 

• Use a square and hold it on the material and bump it up against the straightener. 

Put a line in the material.

• On the material, measure 48” back from the line that you have drawn against the 
straightener and put another square line on the material. These two line need to be 

perfectly 48” apart. Get help holding the tape measure, make sure that the tape 
measure is straight and flat against the material. Also burn an inch on the tape 

measure so you are as precise as you can be.

• Remeasure the distance just to be sure that the helper holding the tape didn't make 

a mistake.

• Go to Tools > Feed. Move the material 48”. Use the square and see if the second 
line has moved to where the first line was. If so, no calibration is needed. If not go 

to Tools >Tool settings. The “Feed Encoder Counts per Inch” Value will need to be 
adjusted.

• To figure out the correct calibration value, you have to use this formula. 

Commanded distance / Distance the material moved * the current “Feed Encoder 
Counts per Inch” Value

• Example: 48.0 / 48.125 * 1662.0 = 1657.6

We highly recommend that you click on the 

link below and watch the video on this step. 

Calibrate the material feed system

https://youtu.be/vjqIRm0p1Bw
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Machine Calibration Continued:

Calibrating the Bend Head

Bump Bend Calibration:
• Calibrating the bend head requires you to run 4 different test files that are located in 

C:\Jobs\Fusion Test Files. You have to run each file and adjust the bend values until 

the machine makes the correct shape.

• To calibrate a Bump Bend, Start with file (1.5 - inch diameter test Neg.DXF). Run 

the shape. The diameter of the semi circle should measure 1-1/2” across. +- 1/16”. 
If the shape needs adjusting, then go to Tools > Material Settings. Make sure that 

you have the correct material selected then make a change to the “Bump Bend 
Negative” value. Change the value by 2 degrees at a time.

• If the bend is to much then, decrease the negative Bump bend value. If the bend is 

to not enough then, increase the negative Bump bend value.

• Repeat these step for a Positive Bump Bend. Use test file (1.5 - inch diameter test 

Pos.DXF).

We highly recommend that you click on the 

link below and watch the video on this step.
Go To Next Page



CLN Fusion Manual Ver. 2 96

Calibrating the Bend Head Continued

Roll Bend Calibration:

• To calibrate a Roll Bend, Start with file (6 - inch diameter test Neg.DXF). Run the 

shape. The diameter of the semi circle should measure 6” across. +- 1/2”. If the 
shape needs adjusting, then go to Tools > Material Settings. Make sure that you 

have the correct material selected then make a change to the “Roll Bend Negative” 
value. Change the value by 2 degrees at a time.

• If the bend is to much then, decrease the Roll bend negative value. If the bend is to 

not enough then, increase the Roll bend negative value.

• Repeat these step for a Roll Bend Positive. Use test file (6 - inch diameter test 

Neg.DXF).

Machine Calibration Continued:

We highly recommend that you click on the 

link below and watch the video on this step.
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Com Port (0) 75 Error

• The Fusion software starts on 2 stages. The first stage closes all 

existing parts of the program that are running in the background. If it 

can’t successfully shut them down a message will pop up in a large 
black screen telling you to shut it down with the task manager. Press 

reset on the side of the machine. Then try starting it again.

• Make sure that both emergency stops are released.

• Try pressing reset on the side of the machine. 

• Make sure that the green ready light next to the reset button is on.

• Try restarting the program.

If the program still will not start:
• Click on this link to continue Com Port (0) 75 Error

Software Will not Start:
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Com Port (0) 75 Error Continued

• Take a look and Identify what kind of Com port the 

computer is using. There are 3 deferent kind of Com Ports 

that it could be. Com Ports and VGA look the same other 

than the VGA has 15 pins, and a Com Port has 9. Make 

sure that you're not looking at the monitor cable.

1. A Comport that is directly mounted to the mother board. 

Should be Com Port (1)

2. A PCI to Com Port card will usually have 2 Ports. The Com 

Ports should be (3 and 4). We usually use Com Port 3

3. USB to Com Port adapter. Is usually Com Port 3

• Go to the device manager and make sure that the com port 

is working correctly. Take note of the com Port number, you 

will need this number later.

Software Will not Start Continued:

9 Pin Com Port
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Com Port (0) 75 Error Continued

• You need to manually edit the data file that contains the Com 

Port setting for the Fusion program.

• Go to the windows folders, C:\Fusion. Double click on  

CLNSETUP.DAT It should open with note pad.

Software Will not Start Continued:
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Com Port (0) 75 Error Continued

• You will see a line of numbers. From left to right 

change the 6th number to the active Com Port that you 

saw in the device manager.

• Be careful not to change anything else while you are 

editing this file. Even the spaces are important. If you 

have any doubt that you made an accidental change 

just close it without saving it and start over.

• Save and close CLNSETUP.DAT

• Press reset on the machine.

• Try restarting the program.

• If the program still will not start, then try repeating 

these steps with the other Com Ports that are  

available in the device manager.

• If the program still fails to start, contact tech support at 

CLN of South Florida Inc.

Software Will not Start Continued:
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Material stuck in the machine
• First press the emergency stop. Use the hand wheel on the feeding assembly to 

see if you can figure out where it got stuck. Turn the wheel back and forth slowly 

while inspecting all possible places that it could be hitting something.

Stuck some where in the bend head
• The number one reason for a jam, is the material is not loaded correctly. A good 

indication is that the flange is larger than it should be. The flange should be ½”, if its 
more that that, the material will get stuck in the bend head where you can’t easily 
see it. To make sure that the material is loaded correctly See Loading Material. 

• Material stuck in the notching station

• Dull Notching Dies:

Material Stuck in the Machine:
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Material stuck in the notching station:

• Notcher not completely going through the material
• If the notcher is not notching through the material all the way. You must check the air 

pressure at the time that the machine jammed. You could have had a loss of pressure at the 

time of the incident and the air pressure recovered before you notice that it dropped. It 

should be set to 80 PSI and not drop below 70 while running.

• The linkage from the air cylinder could be wore out preventing the tool to cycle all the way. 

Lack of maintenance will cause this.

• Try increasing the notch in delay see Tool Timing

• Examine the notch cycle manually. Press the Emergency stop. Wear a pair of gloves and 

grab ahold of the notching arm pull it toward you to cycle the notcher. Make sure that it 

moves smoothly Then do it again with material under the dies. You should be able to cycle it 

by hand. Compare the resistance to the other notcher that’s function correctly. Look for 
anything that looks abnormal.

• Notcher not returning through the material 

• The linkage from the air cylinder could be worn out preventing the tool to cycle all the way.

• Try increasing the notch out delay see Tool Timing

• The artwork could have a series of points very close together (about .005” apart.) It will 
appear that the notcher didn’t return through the material. However, this will cause the 
material to lift back with the die. You will also hear the notcher cycle very quickly like a 

machine gun. To fix this clean up the artwork.

Material Stuck in the Machine Continued:

CLN Fusion Manual Ver. 2
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Material stuck in the notching station 
Continued:

Dull Notching Dies:
The dies could be wore-out and need sharpening. To 

sharpen the dies, you must remove the Notching 

assembly and send it to CLN of South Florida..

Removing a Notching Assembly:

• Remove the Clevis pin.

• Remove the chip slide.

• Remove the 4 bolts that hold the notcher in place.

• Remove the 2 bolts that hold the adjustment block.

• If you don’t turn the adjustment bolt the notcher will 
reinstall exactly where it was.

Material Stuck in the Machine Continued:

CLN Fusion Manual Ver. 2
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• If the notches are not lining up with the Break Bend. The first thing to check is the Encoder 

calibration. See Encoder Calibration. 

• If the problem is inconsistent. Let’s say on some letters everything is fine and other letters 
the bend gets off the notch. There are two possibilities. First Identify what kind of encoder 

you have on the machine. Its either a pivot arm Encoder or a self tensioning Encoder.

Pivot Arm Encoder

• For a Pivot Arm Encoder, The spring tension could be to lose. See Pivot Arm Encoder 

Adjustment video.

Self tensioning Encoder
Check to see if the Self tensioning Encoder is sliding back and forth in its track. To do so press 

the emergency stop, use the hand wheel and move the lead edge of the material back and 

forth, making contact with the encoder wheel, then backwards coming off the encoder wheel. 

Watch the encoder make sure that the Encoder is moving back and forth about 1/8 inch. This 

will tell you that the spring is doing its job of keeping a consent pressure between the material 

and the Encoder wheel.

The Encoder wheel may be loose on the encoder shaft. Remove the Encoder Assembly and 

check the set screws in the Encoder Wheel. See Encoder Wheel Set Screw video.

The Notch is off the Bend:

CLN Fusion Manual Ver. 2

Pivot Arm Encoder

Self Tensioning Encoder

https://youtu.be/XLmsk8EGGA0
https://youtu.be/ADqyAlklMqs
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• If you click okay to rotate bend head message and the Bend Bar 

rotates counterclockwise, then stops. It most likely missed the 

home sensor. See Bend Head Sensor Adjustment.

Bend Head Crash on Start Up:

CLN Fusion Manual Ver. 2


